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Exercise 1: Creating a shapefi le based network dataset

In this Exercise you will create a simple shapefi le based network dataset 
from a single line feature class and a turn feature class.

Creating a network dataset

1. Start ArcCatalog by either double-clicking a shortcut installed on 
your desktop or using the programs list in your Start menu.

2. Navigate to the C:\arcgis\ArcTutor\Network_Analyst folder in the 
Catalog Tree. (This is the default install location for this data.)

3. Click the Exercise1 folder to show its contents.

4. If the Network Analyst Extension is not enabled, on the Tools menu, 
click Extensions, and in the Extensions dialog, click Network Analyst 
and close the Extensions dialog. 

5. Right-click the Streets shapefi le and choose New Network Dataset. 
This shapefi le contains street data for downtown San Francisco. 

6. The name of the network dataset is set to Streets_ND by default. 
Click Next to continue.

        

 Network Connectivity defi nes how features that participate in a 
network connect to each other. The default connectivity for a network 
dataset places all sources in one connectivity group and assigns all 
edge sources endpoint connectivity. In a shapefi le based network 
there is only one edge source, hence there is no need for multiple 
connectivity groups. Also, we wish to model streets with endpoint 
connectivity. (To see how this is modeled, you may click the 
Connectivity button.)

7. You will accept the default connectivity, therefore Click Next to 
continue.

            

 Earlier versions of ArcView GIS and ARC/INFO support optional 
elevation fi elds to establish connectivity. Each feature in a shapefi le 
or a coverage would be assigned two Z-elevation values, one for each 
endpoint. If the endpoints of line features have the same Z-elevation 
value, connectivity is established. If the values are different, they do 
not connect (e.g. in the case of bridges or tunnels). 

 The elevation fi eld contains logical elevation values for establishing 
connectivity only and does not provide height information for 
the feature. ArcGIS Network Analyst can use this data to modify 
the connectivity settings established in the previous step. ArcGIS 
Network Analyst automatically searches and maps the relevant fi elds. 

8. Click Next to accept the default elevation fi elds settings. If ArcGIS 
Network Analyst fi nds elevation fi elds data in your shapefi le, 
it automatically chooses the Yes radio button and assigns the 
appropriate fi elds.



2

 

 ArcGIS Network Analyst supports turns in a shapefi le based network. 
Turn information (such as turning restrictions and delays) enhance 
the quality of network analysis. Earlier versions of ARC/INFO and 
ArcView GIS used turn tables. These turn tables can be converted 
into turn features and used in the network dataset. You will use turn 
features in Exercise 2.

 In addition, by default Global Turns are selected. Global Turns are 
rules that can be set, such as all left turns have a delay of 15 seconds. 
Such a rule gives preference to right turning movements. The 
advantage of Global Turns is that you do not need to create individual 
turn features for rules that apply to every turn in the network. 

9. Click Yes to model turns in the network.
10. Click Next to continue.

 Network attributes are properties of the network that are used to 
control navigation. Common examples are costs that function as 

impedances over the network. Restrictions like oneway traversal are 
also examples of network attributes. 

 The ArcGIS Network Analyst analyzes the source shapefi le and 
looks for common fi elds like Meters, Minutes (FT_Minutes and 
TF_Minutes, one for each direction), and Oneway. Once it fi nds these 
fi elds, it automatically creates the corresponding network attributes 
and assigns the respective fi elds to them. (This can be viewed by 
clicking the Evaluators button.) 

11. Since the attributes are automatically defi ned and assigned values, 
click Next to continue.

 To use driving directions in a network analysis, they should be set       
in the network dataset.

12. Select Yes to establish driving directions settings for this network 
dataset. 

 The Network Analyst automatically fi nds and maps the fi eld in the 
streets source that will be used to report street names. Additionally 
Length and Time fi elds are automatically mapped as well. 
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13. Click Next to continue.

 14. A summary of all the settings that have been chosen is displayed in 
the following window for your review. 

 Click Finish to create the new shapefi le based network dataset.

 Once created, the system prompts for the network to be built. 
15. Click Yes to build the network.
 

 

 The network dataset has been built when the progress bar disappears.

 The shapefi le based network, Streets_ND, is added to ArcCatalog 
along with the system junctions shapefi le Streets_ND_Junctions. 

16. Select Streets_ND and click on the Preview tab to see the built 
network dataset.

17. Close ArcCatalog.
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Exercise 2: Creating a geodatabase network dataset

In this Exercise you will create a geodatabase based network dataset 
using the streets feature class for Paris.

Creating a network dataset

1. Start ArcCatalog by either double-clicking a shortcut installed on 
your desktop or using the programs list in your Start menu. 

 If the Network Analyst Extension is not enabled, on the Tools menu, 
click Extensions, and in the Extensions dialog, click Network Analyst 
and close the Extensions dialog. 

2. Navigate to the C:\arcgis\ArcTutor\Network_Analyst folder in the 
Catalog Tree. (This is the default install location for this data.)

3. Double-click the Exercise2 folder to expand it.
4. Click the plus sign on Paris.gdb. This will expand the connection tree 

to show you the contents of the geodatabase.
5. Click the RoadNetwork feature dataset. The contents will be listed in 

the Contents tab.
6. Right-click the RoadNetwork feature dataset, click New, then click 

Network Dataset. This will open the New Network Dataset Wizard.

7. Type “ParisNet” as a name for your network dataset.

8. Click Next.
9. Check the Streets feature class to use it as a source for the network 

dataset.

10. Click Next.
11. Click Connectivity to set up the connectivity model for the network.

 The Streets feature class has three subtypes that we wish to use to set 
up the connectivity - Highways, Major Roads and Local Streets.

12. Click the Subtypes button to bring up the Connectivity Settings: 
Subtypes Dialog. Check the Box next to Streets (3) to use the three 
subtypes of Streets. 
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13. Click OK to return to the Connectivity dialog. There are now three 
rows, one for each subtype. 

14. For this network, Highways and Major Roads connect to each other 
at end points. Local Streets connect at any vertex of geometric 
coincidence. Change the connectivity policy of Streets: Local Streets 
to Any Vertex.

15. Click OK to close the Connectivity Group dialog box.
16. Click Next.
17. There is no elevation fi eld data for this dataset, therefore make sure 

No is selected. 
 Elevation fi elds have been used since the earlier versions of ARC/

INFO and ArcView GIS to model connectivity. ArcGIS Network 
Analyst supports this connectivity model. Each feature in a shapefi le 

or a coverage would be assigned two Z-elevation values, one for each 
endpoint. If the endpoints of line features have the same Z-elevation 
value, connectivity is established. If the values are different, they 
do not connect (e.g. in the case of bridges or tunnels). The elevation 
fi eld contains logical elevation values for establishing connectivity 
only and does not provide height information for the feature. 

18. Click Next.
19. Select Yes for modeling turns in the network. Check the box by 

ParisTurns to select the turn feature source.

20. Click Next.
21. There are three attributes that are added by default, Oneway, Minutes 

and Meters. 

 

 ArcGIS Network Analyst inspects all sources and tries to 
automatically assign values for these three attributes.

22. Click Evaluators to inspect the evaluator assigned by source for each 
attribute. Select each attribute from the pull down menu and inspect 
the type and value assigned to it.
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23. Click OK to return to the New Network Dataset Wizard.
24. You will add a new attribute that will restrict movement over the 

turn elements created from ParisTurns. Click Add to bring up the 
Add New Attribute dialog. Type TurnRestriction as the name of the 
attribute and select Restriction as the Usage type. Note that the Use 
by Default option is checked. This restriction will be used by default 
when a new network analysis layer is created. If checked here, it can 
be disabled during analysis.

25. Click OK. A new attribute called TurnRestriction is added to the list.

26. Click Evaluators to assign values by source.
27. Set the Type of Evaluator for ParisTurns to Constant by clicking in 

the Type column, for the ParisTurns row and selecting Constant from 
the dropdown box.

28. Change the Value for ParisTurns to Restricted. The evaluators for 
other sources are set automatically to Traversable under Default 
Values. 

29. Click OK to return to the New Network Dataset Wizard.
30. Click Next to continue.
31. Click Yes to set up directions. Click Directions to open the Network 

Directions Properties Page. Here, you will set up the fi elds used to 
report directions after network analysis.

32. In the General tab, click under the Name column for the Primary row 
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and select FULL_NAME from the dropdown list. In the Paris streets 
data, this fi eld contains the street names that will be used to generate 
directions.

33. Click OK to return to the New Network Dataset Wizard.
34. Click Next to see a summary of the settings defi ned.

35. Click Finish to create the new network dataset.
36. Click Yes to build the network dataset.

 Once the network dataset is built, you should see a new network 
dataset called ParisNet along with the system junctions feature class 
ParisNet_Junctions. Preview the network dataset by selecting it and 
clicking on Preview.

37. Close ArcCatalog.
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Exercise 3: Creating a multimodal network dataset

In this Exercise you will create a multimodal network dataset from 
multiple feature classes within a feature dataset in a geodatabase.

Creating a network dataset

1. Start ArcCatalog by either double-clicking a shortcut installed on 
your desktop or using the programs list in your Start menu.

 If the Network Analyst Extension is not enabled, on the Tools menu, 
click Extensions, and in the Extensions dialog, click Network Analyst 
and then close the Extension dialog. 

2. Navigate to the C:\arcgis\ArcTutor\Network_Analyst\Exercise3 
folder in the Catalog Tree. (This is the default install location for this 
data.)

3. Double-click the Exercise3 folder to expand it.
4. Click the plus sign on Paris.gdb. This will expand the connection tree 

to show you the contents of the geodatabase.
5. Click the Multimodal_Network feature dataset. The contents will be 

listed in the Contents tab.
6. Right-click the Multimodal_Network feature dataset, click New, then 

click Network Dataset. This will open the New Network Dataset 
Wizard.

7. Type “ParisMultiNet” as a name for your network dataset.

8. Click Next.
9. Click Select All to select all the feature classes to participate as 

sources in the network.

10. Click Next.
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11. Click Connectivity to set up the connectivity model for the network.

12. Click the Group Column up-arrow once, to increase the number of 
connectivity groups to 2. Connectivity group 1 represents the metro 
system and connectivity group 2 represents the street network.

13. Check the boxes under the Connectivity Group numbers to assign 
each source to the group they belong to. Click under the column 
labeled 2 for the Streets row to move Streets to connectivity group 2, 
as shown in the graphic below. Click under the column labeled 2 for 
the Metro_Entrances row to assign Metro_Entrances to both groups 1 
and 2. They are the points of transfers between the two networks.

14. Click under the Connectivity Policy column for Metro_Entrances and 
select Override from the dropdown list. 

 Each feature of Metro_Entrances is coincident with a vertex of the 
streets feature class. However the streets feature class has a policy 
of endpoint connectivity. Since the Metro_Entrances are to be 
connected to the streets at the coincident vertex, you have set the 
Metro_Entrances to override the default endpoint connectivity of the 
streets.

15. Click OK to close the Connectivity Group dialog box.
16. Click Next.
17. There is no elevation fi eld data for this dataset, therefore be sure No 

is selected. 
 Elevation fi elds have been used since the earlier versions of ARC/

INFO and ArcView GIS to model connectivity. ArcGIS Network 
Analyst supports this connectivity model. Each feature in a shapefi le 
or a coverage would be assigned two Z-elevation values, one for each 
endpoints. If the endpoints of line features have the same Z-elevation 
value, connectivity is established. If the values are different, they 
do not connect (e.g. in the case of bridges or tunnels). The elevation 
fi eld contains logical elevation values for establishing connectivity 
only and does not provide height information for the feature. 

18. Click Next.
19. Select Yes for modeling turns in the network. Although you have no 

turn feature classes for this network, selecting yes allows the network 
dataset to support global turns. Turn information can be added to an 
existing network dataset, if it supports turns. If you choose no here, 
you will not be able to add turns to this network on a later date.

20. Click Next.
21. There are three attributes that are added by default, Oneway, Minutes 

and Meters. 

 Since this is a multimodal network you will add different time 
attributes based on mode. For automobiles, you will have an attribute 
called Drivetime and for pedestrians, you shall have a Pedestrian_
Time attribute. 
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 The attribute Minutes is added by the Network Analyst by default. 
We can rename this attribute to be called Drivetime. 

22. Select the Minutes row, click Rename, then type “Drivetime”.
         

 The Meters and Drivetime attributes have a yellow warning symbol 
that represents a potential problem with the evaluators. 

23. Select Meters and click Evaluators to inspect values for the Meters 
attribute for each source in the network.

 ArcGIS Network Analyst inspects all sources and tries to 
automatically assign values for the Meters attribute. The Metro_
Lines source and the Streets source have a fi eld called Meters, 
therefore this fi eld is automatically assigned to the sources. 

 For each edge source in the network, attributes need to be assigned 
for each direction of travel. Since the length does not depend on 
direction of travel, the same values are assigned for both directions 
of a source. Network Analyst attempts to assign values for each cost 
attribute for each edge source that participates in the network. In 
this case, Network Analyst was unable to fi nd values for Transfer_
Stations and Transfer_Street_Station sources. Hence a warning 
symbol is present to indicate that there is a problem. 

24. Select all four rows with the yellow warning symbol (two sources 
in both directions), right-click, choose Type, and click Field. The 
yellow warning sign changes to a red exclamation mark indicating an 

incomplete assignment of values.

25. The  four rows, now with the red exclamation mark, should still 
be selected. Right-click the selected rows, choose Value and click 
SHAPE_LENGTH. This will assign values for the Meters attribute 
for the selected sources from the their SHAPE_LENGTH fi eld. 

26. Click Apply.
27. From the Attributes dropdown box, select Oneway. The attribute 

Oneway has been assigned values automatically by the ArcGIS 
Network Analyst for the Streets source.  Since all other sources are 
related to the metro system, they have no oneway restrictions. 

28. From the Attributes dropdown box, select Drivetime.
 The values for the street network are populated automatically by 

Network Analyst. Other edge sources have no values assigned and 
have the warning symbol. 

 The attribute Drivetime will be used to model the travel time using 
automobiles. Since automobiles travel on streets only (and not 
on Metro_Lines or transfers between stations), a valid value of 
Drivetime can exist only for streets (which has been automatically set 
up). 

29. Select all the other edge sources that belong to the metro system 
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(Metro_Lines, Transfer_Station, and Transfer_Street_Station). You 
can use the CTRL key and select each of them. Click on the column 
heading named Type and select Constant.

30. The same rows should still be selected. Hit the F12 key on the 
keyboard to bring up the Constant Value Input box. (Alternately, 
you can also right-click the selected rows, point to Value and select 
Properties to bring up the same input box.) Type -1 and press Enter.

 By assigning a constant of -1, the system will treat the sources as 
restricted when the attribute Drivetime is used as an impedance.

31. Click OK to return to the New Network Dataset Wizard.
32. Click Add to add a new attribute.
33. In the Add New Attribute dialog box, enter “Pedestrian_Time” for 

the Name. Set the Usage Type as Cost, the Units as Minutes and the 
Data Type as Double.

34. Click OK.
35. Select Pedestrian_Time and click Evaluators. 
 The Pedestrian_Time attribute in the network represents the time a 

pedestrian takes on the network. In this case it has two components 
because a pedestrian can utilize the metro system in addition 

to walking on the street network. In the Evaluators dialog, the 
following six sources should already be selected. Metro_Lines (in 
each directions), Transfer_Stations (in each direction) and Transfer_
Street_Station (in each direction). If not, you can use the CTRL key 
and select each of them.

36. Right-click, choose Type, and click Field.

37. The same rows should still be selected. Right-click, choose Value, 
and click TRANSITTIM. 
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38. To set up the Pedestrian_Time for Streets,  click the row for Streets 
in the From-To direction. Hold the CTRL key and click the row for 
Streets in the To-From direction, to select both rows for the Streets 
source.

39. Right-click on the selected sources, point to  Value, and click 
Properties to bring up the Field Evaluators dialog box. 

 On the street network a pedestrian can walk. Hence for the streets 
source, the value of Pedestrian_Time is the walk time for a 
pedestrian. Assuming that a pedestrian walks at 3 km/h, walk time 
in minutes will then be [Meters] * 60 / 3000 where [Meters] is the 
attribute containing length of the edge in meters. 

40. Click on METERS fi eld to move it into the “Value =” location and 
fi nish typing the expression as [METERS] * 60 / 3000 in the Field 
Evaluators Dialog as shown below. Click Verify to verify that the 
expression is correct. Fix if necessary.

41. Click OK to close the dialog and to return to the Evaluators dialog. 
42. Click OK to save the attribute assignment.
43. Click Next.
44. Click Yes to set up directions. Click Directions to open the Directions 

Properties Page. 
45. On the General tab, click the Source dropdown arrow and click 

Streets.

46. Click on Primary in the Street Name Fields list. 
47. Click under the Name fi eld and click FULL_NAME from the 

dropdown list. 

    

48. Click OK.
49. Click Next to see a summary of the settings defi ned.
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50. Click Finish to create the new network dataset.

51. Click Yes to build the network dataset.

 Once the network dataset is built, you should see a new network 
dataset called ParisMultiNet along with the system junctions feature 
class ParisMultiNet_Junctions. Preview the network dataset by 
selecting it and clicking on Preview.

52. Close ArcCatalog.
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Exercise 4: Finding the best route using a network dataset

In this Exercise you will fi nd the best route for the given order of stops 
based on travel time.

Preparing your display

1. If you have Exercise4.mxd open in ArcMap, skip steps 2 to 5.
2. Start ArcMap by either double-clicking a shortcut installed on your 

desktop or using the programs list in your Start menu. Choose Ok to 
start ArcMap with a new empty map.

3. Click File on the Main menu and click Open.
4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network_

Analyst\Exercise4. (This is the default install location for this data.)
5. Double-click Exercise4.mxd.
6. If the Network Analyst Extension is not enabled, on the Tools menu, 

click Extensions, and in the Extensions dialog, click Network Analyst 
and then close the dialog. 

7. If the Network Analyst toolbar is not already present, on the Main 
menu, click View, point to Toolbars, and click Network Analyst.

8. If the Network Analyst Window is not already    
open, click the Network Analyst Window button    

 on the Network Analyst toolbar.
 This is a dockable window which you can dock     

within the ArcMap window or leave undocked.      
In this Exercise the window is docked below the     
Table of Contents.

Creating the Route analysis layer

1. On the Network Analyst toolbar, click the Network Analyst 
dropdown menu and click New Route.  

 
 The Network Analyst Window now contains        

empty lists of Stops, Routes and Barriers    
categories. 

 Additionally, the table of contents contains a new    
Route Analysis Layer.

Adding a stop

Next, you will add the stops between which you will be  
creating the best route.
1. Click Stops(0) on the Network Analyst Window.
2. On the Network Analyst Toolbar, click the Create Network Location 

tool .
3. Click anywhere on the street network in the map to defi ne a new stop 

location.
 The program then calculates the nearest network location and 

symbolizes the stop with the located symbol. The stop will remain 
selected until another stop is placed or until it is unselected.

        
 
 The located stop also displays the number 1. The number  

represents the order in which the stops will be visited by the 
calculated route.  

 You will also notice that the Stops category on the Network Analyst 
Window now lists 1 stop. Expand the Stops category to see the 
Graphic Pick 1 listed there.    

4. Add two more stops on the map. The stops are numbered 2 and 3. 
The order of stops can be changed on the Network Analyst Window. 
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The fi rst stop is treated as the origin and the last, as the destination.

If a stop is not located on the network, it will appear with an unlocated 
symbol.

An unlocated stop can be located on the network by moving it, closer to 
any edge that belongs to the network. On the Network Analyst Toolbar, 
click Select/Move Network Location tool .
Using the Select/Move Network Location tool , click and drag the 
unlocated stop closer to an edge on the network.

  

Setting up the parameters for the analysis

Next, you will specify that your route will be calculated based on time 
(minutes), that U-turns are allowed everywhere, and that one-way 
restrictions must be followed.
1. Click the Analysis Layer Properties button next to Route layer on the 

Network Analyst Window to bring up the Layer Properties dialog for 
Route.

2. In the Layer Properties dialog, click the Analysis Settings tab. Make 
sure the impedance selected is Minutes (Minutes).

3. Do not use time windows. (Leave the box unchecked). Time 
windows are used when certain stops can only be visited at certain 
times. 

4. Do not reorder stops. (Leave the box unchecked). This preserves the 
order of stops as decided by you, when you created the stops.

5. Choose Everywhere from the Allow U-turns dropdown box.
6.  Choose True Shape from the Output Shape Type dropdown box.

7. Check the box labeled Ignore Invalid Locations. This will let you 
fi nd the best route using located stops. Stops that were not located on 
the network will be ignored.

8. Check Oneway in the Restrictions list.

9. Check the Directions settings.
10. Make sure the Distance Units are set to Miles, the Use Time Attribute 

box is checked and the time attribute is set to Minutes.
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5. Close the Directions Window.

Adding a barrier

In this section, you will add a barrier on the route, that represents a road 
block and will fi nd an alternate route to the destination, avoiding the road 
block.
1. In the Window menu, click Magnifi er to bring up the Magnifi er 

window.
2. Click on the title bar of the Magnifi er window and drag to reposition 

the Magnifi er window.  
3. Move the Magnifi er window over the route, to a point where you 

want to add a barrier. The Magnifi er window shows a part of the map 
where you can add a barrier at a zoom of 400%.

4. On the Network Analyst Window, click Barrier (0).
5. On the Network Analyst Toolbar, click the Create Network Location 

tool .

11. Click OK.

Run the process to compute the best route

1. Click the Solve button  on the Network Analyst toolbar.
 The route polyline appears in the map and in the Route category of 

the Network Analyst Window.

2. Click the plus (+) sign next to Routes on the Network Analyst 
Window to show the Route.

3.  Right-click the new route called ‘Graphic Pick 1 - Graphic Pick 3’ 
and click Directions Window to display driving directions.

4. The Directions Window can also be displayed with turn-by-turn maps 
that can be shown by clicking on the Map link.
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6. In the Magnifi er Window, click anywhere on the route, to place a 
barrier.

7. Click the Solve button  on the Network Analyst toolbar. A new 
alternative route is computed, avoiding the barrier.

8. Close the Magnifi er Window.

Saving the best route

1. Right-click Routes (1) on the Network Analyst Window and click 
Export Data.

2. Type in a location and shapefi le name to save the results such as 
C:\Data\Exercise4_Route.shp in the Output shapefi le or feature class 
fi eld.

3. Click OK. The best route generated is saved to the specifi ed 
shapefi le.

4. Click NO when prompted to add the exported data to the map as a 
layer. 

5.  If you do not plan to work on any other Exercise, close ArcMap. 
Click No to discard all changes.

6.  If you do plan to work on other Exercise, then do a File New in 
ArcMap and Click Yes to discard all changes to the current map 
document.
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Exercise 5: Finding the closest fi re stations 

In this Exercise you will fi nd the closest four fi re stations that can respond 
to a fi re at a given address. You will also generate the fastest route from 
each of these fi re stations that will be provided to each driver of the fi re 
engine.

Preparing your display

1. If you have Exercise5.mxd open in ArcMap, skip steps 2 to 5.
2. Start ArcMap by either double-clicking a shortcut installed on your 

desktop or using the programs list in your Start menu. Choose Ok to 
start ArcMap with new empty map.

3. Click File on the Main menu and click Open.
4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network_

Analyst\Exercise5\Exercise5.mxd. (This is the default install location 
for this data.)

5. Double-click Exercise5.mxd.
6. If the Network Analyst Extension is not enabled, on the Tools menu, 

click Extensions, and in the Extensions dialog, click Network Analyst 
and close the Extensions dialog. 

7. If the Network Analyst toolbar is not already present, on the Main 
menu, click View, point to Toolbars, and click Network Analyst.

8. If the Network Analyst Window is not already    
open, click the Network Analyst Window button    
  on the Network Analyst toolbar.

 This is a dockable window which you can dock     
within the ArcMap window or leave undocked.     
In this Exercise, the window is docked below the    
Table of Contents.

Creating the Closest Facility analysis layer
1. On the Network Analyst toolbar, click the Network Analyst 

dropdown menu and click New Closest Facility.    

 
 

 The Network Analyst Window now contains an     
empty list of Facilities, Incidents, Routes, and    
Barriers categories. 

 Additionally, the Table of Contents contains a new    
Closest Facility analysis (group) layer.

Adding facilities

Next you will add facilities from a point fi le for which    
a layer fi le has been created.
1. Right-click Facilities (0) in the Network Analyst     

window and click Load Locations.
2. Select Fire_Station from the Load From dropdown list. Keep the 

default settings.       
                

3. Click OK.
 40 fi re stations are listed in the Network Analysis    

window and are displayed as facilities on the map.
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Adding an incident

Next, you will fi nd a street address (1202 Twin Peaks Blvd) and add it as 
an incident for Closest Facility Analysis.
1. Click Incidents(0) on the Network Analyst Window to select it as the 

feature layer to which you will add the street address as a network 
location.

2. Select Find from the Edit menu to bring up the Find Dialog

3. In the Addresses tab, Select “SanFranStreets” from the Choose an 
address locator dropdown list.

4. Enter “1202 Twin Peaks Blvd” in the text box labeled Street or 
Intersection.

5. Click Find. One location is found with that street address and is listed 
as a row in the table in the Find Dialog.

6. Right-click the row and click “Add as Network Location”. This adds 
the located address as an incident on the Network Analyst Window 
and on the map.

7. Close the Find Dialog.
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Run the process to identify the closest facility

1. Click the Solve button  on the Network Analyst toolbar.
 The routes appear in the Map and in the Route Category on the 

Network Analyst Window.

 

 Note that only 2 fi re stations were found to be closest to the fi re 
within the three minute cutoff. You can optionally, increase the cutoff 
value to 4 minutes and see how many fi re stations are found.

2. Click the Directions Window button  in the Network Analyst 
Toolbar to generate directions for routes from each fi re station.

 

 If you do not plan to work on any other Exercise, close ArcMap. 
3. Click No to discard all changes.

        

Setting up the parameters for the analysis

Next, you will specify the parameters for your Closest Facility analysis.
1. Click the Closest Facility Properties Button next to Closest Facility 

on the Network Analyst Window to bring up the Layer Properties 
dialog.

2. In the Layer Properties dialog, click the Analysis Settings tab.
3. Click the Impedance dropdown arrow and click Minutes (Minutes).
4.  Set the Default Cutoff value to 3. ArcGIS will search for fi re stations 

that are within three minutes of the fi re. Any fi re station outside of 
three minutes drive time will be ignored.

5. Increase the Facilities to Find from 1 to 4. ArcGIS will attempt to 
search for four fi re stations from the fi re site, within the three minute 
cutoff. If there are only three fi re stations within the three minute 
cutoff, then the fourth fi re station will not be found. 

6. Under Travel From, select Facility (fi re station) to Incident (fi re).
7. Select Everywhere from the Allow U-Turns dropdown box.
8. Select True Shape from the Output Shape Type dropdown box.
9. Check the box labeled Ignore Invalid Locations. This will let you 

fi nd the best route using located stops. Stops that were not located on 
the network will be ignored.

10.  Check Oneway in the Restrictions list.
11. Click OK to        

save the settings.
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Exercise 6: Calculating service area and creating a OD Cost Matrix

In this Exercise you will create a series of polygons representing the 
distance that can be reached from a facility within a specifi ed amount 
of time. These polygons are known as service area polygons. You will 
calculate 3-, 5-, and 10-minute service area polygons for six warehouses 
in Paris. You will also fi nd out how many stores lie within each of these 
service areas. You have to identify one warehouse that should be relocated 
to better service the stores. Additionally, you will create an Origin-
Destination Cost Matrix for delivery of goods from the warehouses to all 
the stores within a 10-minute drive time. Such a matrix is used as an input 
for logistics, delivery, and routing analyses.

Preparing your display

1. If you have Exercise6.mxd open in ArcMap, skip steps 2 to 5. 
2. Start ArcMap by either double-clicking a shortcut installed on your 

desktop or using the programs list in your Start menu.Choose Ok to 
start ArcMap with new empty map.

3. Click File on the Main menu and click Open.
4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network_

Analyst\Exercise6\Exercise6.mxd. (This is the default install location 
for this data.)

5. Double-click Exercise6.mxd.
6. If the Network Analyst Extension is not enabled, on the Tools menu, 

click Extensions, and in the Extensions dialog, click Network Analyst 
and close the Extensions dialog. 

7. If the Network Analyst toolbar is not already present, on the Main 
menu, click View, point to Toolbars, and click Network Analyst.

8. If the Network Analyst Window is not already        
open, click the Show/Hide Network Analyst    
Window button  on the Network Analyst toolbar.

 This is a dockable window which you can dock     
within the ArcMap window or leave undocked.     
In this Exercise the window is docked below the     
Table of Contents.

Creating the Service Area analysis layer

1. On the Network Analyst toolbar, click the Network Analyst 
dropdown menu and click New Service Area.     
  

 The Network Analyst Window now contains       
an empty list of Facilities, Barriers, Lines, and     
Polygons categories. 

 Additionally, the table of contents contains a new  
Service Area analysis layer.

Adding facilities

Next, you will add warehouses as facilities for which the service area 
polygons will be generated.
1. Right-click Facilities (0) on the Network Analyst Window and select 

Load Locations. Select Warehouses in the Load From dropdown list 
and click OK.

  

 Click the plus (+) sign next to  Facilities (6)  in the Network Analyst 
Window to show the list of six facilities. The facilities are also visible 
on the map.   
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Setting up the parameters for the analysis

Next, you will specify that your service area will be calculated based 
on Drivetime (minutes). Three service area polygons will be calculated 
for each facility, one at 3 minutes, one at 5 minutes, and another at 10 
minutes. You will specify that the direction of travel will be from the 
facility, not towards the facility, that no U-turns are allowed, and that one-
way restrictions must be followed.
1. In the Network Analyst Window, click the Service Area Properties 

Button  to bring up the Layer Properties dialog box
2. Click the Analysis Settings tab.
3. Click the Impedance dropdown list and select Drivetime (Minutes).
4. Type “3 5 10” in the Default polygon breaks text box. (Enter this as 3 

5 10, the three numbers are separated by a space, without the quotes.)
5. Under Direction, click Away from facility.
6. Click Nowhere from the Allow U-turns dropdown list.
7. Check Oneway in the Restrictions list to honor one way restrictions.
8. Check the Ignore Invalid Locations checkbox.

9. Click the Polygon Generation tab.
10. Make sure that Generate Polygons is checked.
11. Click Generalized for Polygon Type. This results in faster analysis. 

Detailed polygons are much more accurate, but need more time to be 
generated.

12.  Un-check the Trim Polygon option. This is post-process that trims the 
outside polygon to remove spikes but takes a little longer to run.

13.  Click Overlapping polygons per facility under Multiple Facilities 
Options. This results in individual polygons per facility that may or 
may not overlap.

14. Click Rings for the Overlap type. This excludes areas of smaller 
breaks from the polygons of a bigger break.

15. Click Apply to save the settings.

16. Click the Line Generation tab.
17. Leave the box labeled Generate Lines unchecked. 

    

18.  Click OK to save       
your settings.
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Run the process to compute the Service Area

1. Click the Solve button  on the Network Analyst toolbar.
 The service area polygons appear on the map and on the Network 

Analyst Window.
 There is a transparency set by default for the Polygons layer. This 

shows the underlying layers and gives an idea of the area under the 
polygons with respect to the street network.

Identifying stores that do not lie within any polygon

1. In the table of contents select and move the Stores feature layer to the 
top to improve visibility.

   

2. Choose Select by Location from the Selection menu.

3. Create the selection query in the Select by Location to select features 
from Stores that are completely within Polygons, as shown below.

4. Click Apply. This will select all stores that lie within service area 
polygons.

5. Click Close. 
 You want to select stores that are not within the service area 

polygons, which is the inverse of the current selection. To get the 
selection of stores that are not within the service area polygons, you 
can switch the selection.

6. Right-click Stores in the Table of Contents, point to Selection and 
choose Switch Selection.
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7. The selection now shows the distribution of stores not contained in 
any service area polygon. You use this selection to identify the area 
to which you will relocate a warehouse. This area appears to be in the 
center of the map.

8. Right-click Stores in the Table of Contents, point to Selection and 
choose Clear Selected Features.

Relocating the least accessible warehouse

1. Look at the service area polygons of Warehouse #2. There are 
no stores that lie within the 3-, 5- or 10-minute service areas of 
Warehouse #2.  Hence, you will relocate Warehouse #2 to better 
service the stores. 

2. On the Network Analyst Window, select Warehouse #2 under 
Facilities (6).

3. Use the Select/Move Network Location Tool  to move Warehouse 
#2 to the center of the map, as shown in the fi gure below.

Run the process to compute the Service Area

1. Click the Solve button  on the Network Analyst toolbar.
 The service area polygons appear on the map and on the Network 

Analyst Window.
 

Identifying the service area polygon that each store lies 
within

1. In the table of contents, right-click Stores feature layer, point to Joins 
and Relates and select Join...
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2. Choose Join data from another layer based on spatial location

3. Select Polygons as the layer to join to this layer.

 4. Select the fi rst radio button labeled “it falls inside” to add the 
attributes of polygon to all points that fall inside the polygon. 

5. Specify the output shapefi le to save the result of the join as 
StoreswithPoly.shp. 

6. Click OK to perform the join.
7. Right-click the newly added StoreswithPoly feature layer and select 

Open Attribute Table. Each row displays the name of the store and 
polygon it falls under. You can use this table to generate other useful 

categories such as the number of stores within 0-3 minute service 
area of warehouses.

8. Close the attribute table.
 You can optionally export your facilities (including the one you 

moved to a new location) as a feature class. 
9. Right-click Facilities (6) on the Network Analyst Window and click 

Export Data
10. In the Export dropdown list, click All features.
11. Set the coordinate system to be used by choosing the third radio 

button labeled “the feature dataset you export the data into” 
12. Type “C:\arcgis\ArcTutor\Network_Analyst\Exercise6\

NetworkAnalysis.mdb\AnalysisObjects\New_Warehouses” as the 
output feature class. You can choose another location and name for 
the output if you do not want to write to the input database.  

13. Click OK. 
14. Choose No when prompted to add the     

feature class to the map. You will not     
be using this feature class for the     
remaining exercise.
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 Optionally, you can create an Origin-Destination cost matrix for 
deliveries from the new warehouses to each store. The results of this 
matrix can be used to identify the stores that will be serviced by each 
warehouse within a 10-minute drive time. Also, you would like to 
fi nd the total drive time from each warehouse to its stores. 

Creating the OD Cost Matrix analysis layer
1. In the table of contents, uncheck Service Area analysis layer and 

StoreswithPoly to improve readibility of the map.
2. On the Network Analyst toolbar, click the Network Analyst 

dropdown menu and click New OD Cost Matrix.

 The Network Analyst Window now contains an empty list of Origins, 
Destinations, Lines, and Barriers categories.     
             

 
 Additionally, the table of contents contains a new OD Cost Matrix 

analysis layer.

 

Adding origins

You can use the facilities from Service Area Analysis (in the previous 
section) as origins. If you have not completed the section on Service Area 
Analysis, you can alternately use the Warehouses feature layer.
1. Right-click Origins (0) on the Network Analyst Window and click 

Load Locations.
2. Select ServiceArea\Facilities in the Load From dropdown list. (If you 

did not complete the previous section on service area analysis, you 
can use Warehouses instead. Note that your results will not resemble 
the results in this exercise.) 

3. Uncheck the Selected Features Only check.

4. Click Use Network Location Fields radio button under Location 
Position. Using network location fi elds will allow ArcGIS to use 
the located position of Service Area facilities to locate the origins 
again. This is much faster than using search tolerance to locate them 
again. (If you are loading Warehouses, you will need to click the use 
Geometry radio button and set the Search Tolerance to 50 meters.)

5. Click OK.
 The Network Analyst Window now shows six origins under the 

Origins list and on the map.

Adding destinations

Next you will add the stores as destinations.
1. Right-click Destinations (0) on the Network Analyst Window and 

click Load Locations.
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2. Choose Stores in the Load From dropdown list.
3. Under Location Analysis Properties, for the property Name, select 

the fi eld “NOM” from the dropdown list. Since the fi eld name is in 
French, ArcGIS Network Analyst was unable to map the fi eld name 
automatically.

4. Click OK.
The Network Analyst Window now lists 21      
destinations under the Destinations list.            

These destinations are also displayed on the map.
  

Setting up the parameters for the analysis

Next, you will specify that your OD Cost Matrix will be calculated based 
on time (Drivetime).You will set a default cutoff value of 10 minutes and 
will ensure that all destinations are found within the specifi ed cut off. 
Additionally, you will specify that U-turns are allowed everywhere and 
the output Shape type should be a straight line. Since all these trips are 
on roads, one-way restrictions must be followed. All invalid locations 
(locations that were not located) will be ignored.
1. Click the ODCostMatrix Properties Button  next to 

ODCostMatrix on the Network Analyst Window.

2. Click the Analysis Settings tab.
3. Click the Impedance dropdown list and click Drivetime (Minutes).
4. Input 10 in the Default Cutoff Value dropdown list. This will create 

origin-destination paths from each warehouse to all stores that can be 
reached within 10 minutes.

5. Select  <All>  from the Destinations to Find dropdown list.
6. Select Everywhere from the Allow U-turns dropdown list.
7. Select Straight Line from the Output Shape Type dropdown list.
8. Check Oneway in the Restrictions list.
9. Check Ignore Invalid Locations 
10.  Click OK save the parameters.
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Run the process to create the OD Cost Matrix

1. Click the Solve button   on the Network Analyst toolbar.
 The OD lines appear on the map. The number of lines in this tutorial 

are 24. These may be different for you depending on where you 
relocated Warehouse #2.

2. Turn on the Service Area Layer, and display the Lines on top of the 
service areas of the warehouses.

Allocating stores to warehouses

Based on the OD Cost Matrix, you can now identify the stores that would 
be served by each warehouse.

1. Right-click on Lines (24) on the Network Analyst Window and click 
on Open Attribute Table to open the OD cost matrix.

2. The Attributes of Lines represents the origin destination cost matrix 
from each warehouse to stores within a 10 minute drive time in 
Paris. The OriginID column contains IDs of warehouses. The 
DestinationID column contains IDs of stores. The DestinationRank is 
a rank assigned to each destination that is served by a store based on 
the total drive time. For example, in the table below, for Warehouse 
#1, DestinationID 23 has a rank of 1 and DestinationID 24 has a rank 
of 2. This is because it takes less time to go from Warehouse #1 to 
DestinationID 23. (This may be differerent for you, as your analysis 
results are dependent on the source feature class of the origins and 
destinations.)

 The OD cost matrix displays the stores serviced by each warehouse 
along with the total drive time for each route. Some stores are within 
a 10 minute accessibility zone of more than one warehouse and can 
be served by any one of them.  The OD cost matrix can also be used 
as an input in logistics routing models, that use origin destination 
matrices to allocate goods and services. 

3. Exit ArcMap and do not save any changes to the Exercise6.mxd.
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Exercise 7: Creating a model for route analysis

In this Exercise you will create a model for fi nding the fastest delivery 
route connecting 21 stores in Paris.

Preparing your display

1. If you have Exercise7.mxd open in ArcMap, skip steps 2 to 7. 
2. Start ArcMap by either double-clicking a shortcut installed on your 

desktop or using the programs list in your Start menu. 
 If the Network Analyst Extension is not enabled, on the Tools menu, 

click Extensions, and in the Extensions dialog, click Network Analyst 
and close the Extensions dialog. 

3. Click File on the Main menu and click Open.
4. In the Open dialog box, navigate to C:\arcgis\ArcTutor\Network_

Analyst\Exercise7. (This is the default install location for this data.)
5. Double-click Exercise7.mxd.
6. If the Network Analyst toolbar is not already present, on the Main 

menu, click View, point to Toolbars, and click Network Analyst.

7. If the Network Analyst Window is not already    
open, click the Network Analyst Window button                   

 on the Network Analyst toolbar.
 This is a dockable window which you can dock     

within the ArcMap window or leave undocked.     
In this exercise, the window is docked below the table of contents.

8. In the table of contents, check the check boxes by the Stores layer to 
show it on the map.

9.  In the table of contents, uncheck the check box by the Metro System 
group layer to hide it on the map.

                                 

Creating the Model

1. On the Standard toolbar, click the Show/Hide ArcToolbox Window 
Button  to show the ArcToolbox Window.

          
      

 

2. Right-click ArcToolbox in the ArcToolbox window and select New 
Toolbox.

3. Name the newly added toolbox “NetworkModel”.
4. Right-click on NetworkModel toolbox, select New and then Model. 

A new model appears in the NetworkModel toolbox and in the map 
window.
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Creating the Route Layer in the model

Next you will create the route layer within the model. The workfl ow 
for using Network Analyst in a model is the same as the workfl ow for 
using Network Analyst in ArcMap.  First, you create a route layer and 
set properties.  Next, you add the network locations (stops) to be used as 
inputs.  Last, you solve and display the results.
1. Select the Make Route Layer tool in the Analysis Toolset of the 

Network Analyst Tools toolbox and drag it into the model.

  

2. Double-click the Make Route Layer Tool in the model, to set its 
properties. 

3. Click the ParisNet as the Input Analysis Network in the dropdown 
list. 

4. In the Impedance attribute dropdown list, click Drivetime.
5. Check the Reoder stops to fi nd optimal route checkbox.
6. In the Preserve ordering of stops dropdown list, click PRESERVE_

BOTH

7. Click OK to continue. The Input analysis network is now added to 
the model. The Make Route Layer tool becomes yellow in color and 
the output layer becomes green. Click the Full Extent button  to 
view the entire model.

Adding stops in the model
Next you will add the stores as stops by using the Add Locations tool. 
1. Select the Add Locations tool in the Analysis toolset of the Network 

Analysis toolbox and drag it into the model.

2. Select the Stores feature layer in the table of contents and drag it into 
the model to the left of the Add Locations tool.
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3. Select the Add Connection Tool  and connect Stores to the Add 
Locations tool.

4.  Using the Add Connection tool  , connect the output layer called 
Route to the Add Locations tool. The Add Locations tool becomes 
yellow in color.

 Click the AutoLayout button  to arrange the model. Click the Full 
Extent button  to view the entire model.

            

Adding the solve function and fi nding the best route

1. Select the Solve tool in the Analysis toolset in the Network Analyst 
toolbox and drag it into the model.

 

2. Using the Add Connection tool  , connect the output layer called 
Network Analyst Layer to the Solve tool. The Solve tool becomes 
yellow in color and the output layer becomes green. Click the 
AutoLayout button  to arrange the model. Also click the Full 
Extent button  to view the entire model.

3. Using the Select tool  right-click on the output layer of the Solve 
tool (Network Analyst Layer) and click Add To Display. This will 
add the fi nal output to the map.

4. Click on the Save button  to save the model.
5. From the Model menu, choose Run Entire Model to perform the 

analysis.

6. Close the model to inspect the results. Click Yes, when prompted to 
save the model.

 A new Route layer is added to the map, the Network Analysis 
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window has all the stops and the resultant route. The route is also 
displayed on the map.

7. To access the shortest path feature class for further analysis, link 
the output of the model to a Select Data tool found in the Data 
Management\General toolbox. Double-click the Select Data tool to 
set it’s properties. Once the form comes up, change the Child Data 
Element to Route.

8. Link the output of the Select Data tool to a CopyFeatures tool from 
Data Management\Features toolbox. Double-Click on the Copy 
Features tool and type in c:\temp\path.shp and close the form. Now 
running the entire model will solve the path, select the route sub layer 
and export it out as a shape fi le.

9. Right-click the Model in the NetworkModel toolbox and select 
Delete. Click Yes to verify the deletion.

8. Exit ArcMap and do not save any changes to the Exercise7.mxd.
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